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Symbol Description

DANGER indicates a hazard with a high level of risk, 
which, if not avoided, will result in death or serious 
injury.

WARNING indicates a hazard with a medium level of 
risk, which, if not avoided, could result in death or 
serious injury.

CAUTION indicates a hazard with a low level of risk, 
which, if not avoided, could result in minor or 
moderate injury.

NOTICE indicates a hazard with a potentially 
hazardous situation, which, if not avoided, may result 
in property damage.

Caution, risk of danger. Consult the relevant user 
documentation.

Caution, risk of electric shock.

Caution, lifting hazard.

Caution, hot surface.

General Safety Symbols and Procedures
The following table lists the safety and common symbols that may be used in this 
document and on the equipment. Before performing manipulations with the 
equipment, you should read all sections regarding safety in the User Guide 
accompanying the equipment.

If applicable, following subsections give general procedures related to the tasks 
you may be asked to perform in this document. Additional safety procedures are 
given before any task requiring specific safety precautions.
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Symbol Description

Caution, risk of fire.

Caution, risk of explosion.

Caution, belt drive entanglement hazard.

Caution, chain drive entanglement hazard.

Caution, gear entanglement hazard.

Caution, hand crushing hazard.

Static sensitive contents. Observe precautions for 
handling electrostatic discharge sensitive devices.

Notice, non-ionizing radiation.

Consult the relevant user documentation.

Radio Equipment Directive (RED) geographical 
restrictions – consult the relevant user 
documentation.
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Symbol Description

Direct current.

Alternating current.

Both direct and alternating current.

Three-phase alternating current.

Earth (ground) terminal.

Protective conductor terminal.

Frame or chassis terminal.

Equipotentiality.

On (supply).

Off (supply).

Equipment protected throughout by double 
insulation or reinforced insulation.



General Safety Symbols and Procedures

6 © Festo Didactic

Symbol Description

In position of a bi-stable push control.

Out position of a bi-stable push control.
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About This Document
Computer-based teaching technologies are becoming more and more widespread in 
the field of education. The Data Acquisition and Control for Electromechanical 
Systems (LVDAC-EMS) is witness to this new approach.

The LVDAC-EMS system is a complete set of computer-based Instruments such as 
the Metering window, Oscilloscope, Phasor Analyzer, and Harmonic Analyzer. The 
system runs on a personal computer under the Microsoft® Windows® operating 
environment. LVDAC-EMS allows measurement of voltage, current, power, power 
factor, speed, and torque, among others. It also allows the observation of electrical 
signals in both the time and frequency domains, thereby providing students and 
instructors with tools that clearly demonstrate concepts related to electric power 
technology.

The LVDAC-EMS system is built around the Data Acquisition and Control 
Interface (DACI) module. The DACI module interconnects the modules of the Electric 
Power Technology Training Equipment with the personal computer and processes 
all signals. These signals are high-level voltages and currents, among others. The 
signals are converted into data before being stored in the computer. The LVDAC-
EMS software uses these signals to display all information and measurements 
related to them. The LVDAC-EMS system also allows data recording and graphical 
representation, as well as a stand-alone mode of operation. It offers great 
possibilities and versatility in the teaching of electric power technology.

This user guide is designed to get you familiar with the various computer-based 
instruments, such as the Metering window, Oscilloscope, Phasor Analyzer, and 
Harmonic Analyzer. It is divided into five learning units.

Learning units 2 to 5 each deals with a different computer-based instrument.

Learning unit 6  is a step-by-step hands-on procedure that shows how to measure 
electrical power in three-phase circuits using the Metering window.

This user guide is intended for both instructors and students. It is recommended 
that all students perform the hands-on procedures in this guide before they start 
performing any other hands-on procedures using the Electric Power Technology 
Training Equipment.

This training system uses industrial-grade components to provide an experience as 
close as possible to field training. However, the complexity and inherent risks 
associated with industrial components may be present when using the system. 
Hence, trainees and instructors must understand the principle of operation of the 
Electric Power Technology Training Equipment before using it.

Learning unit 2  allows you to become familiar with the operation of the 
Metering window. It also shows how to record data in the Data Table and 
plot graphs using the recorded data.

Learning unit 3 deals with the operation of the Oscilloscope.

Learning unit 4 describes the operation of the Phasor Analyzer.

Learning unit 5  allows you to get familiar with the operation of the 
Harmonic Analyzer. A step-by-step hands-on procedure in each of these 
sections shows how to use the corresponding computer-based instrument.
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Learning Unit 1

LVDAC-EMS software

Installing the LVDAC-EMS software

If you are using the Data Acquisition and Control Interface (DACI) and/or the 4 
Quadrant Power Supply and Dynamometer Controller, install and run the LVDAC-EMS 
software as directed below.

Running the LVDAC-EMS software
The LVDAC-EMS software can be run in the hardware connected mode or in the stand-
alone mode. In the hardware connected mode, the values of the parameters displayed 
by LVDAC-EMS come from samples of signals sensed by the Data Acquisition and 
Control Interface (DACI), and/or the 4 Quadrant Power Supply and Dynamometer 
Controller. In the stand-alone mode, the parameter values displayed by LVDAC-EMS 
come from computer-simulated signals, and thereby, the DACI and 4 Quadrant Power 
Supply and Dynamometer Controller are not required.

1. Open a Windows session as an administrator.

2. On the host computer, check for any older versions of the LVDAC-EMS software, 
and make sure to remove them.

Download the LVDAC-EMS software as a LVDacEms*****.zip file from a link at the 
bottom of the following page:

LVDAC-EMS

LVDAC-EMS

https://labvolt.festo.com/Website/solutions/
6_electricity_and_new_energy/
98-9063-00_data_acquisition_and_control_interface

When the LVDacEms*****.zip file download has completed, extract all 
compressed (zipped) files to the desired folder on your computer. In the extracted 
files, find and run the Setup.exe file and follow the indications provided by the 
LVDAC-EMS Installation Wizard to complete software installation.

3.

4. The installation is now complete.
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In this procedure, it is assumed that both the DACI and the 4 Quadrant Power Supply 
and Dynamometer Controller are used and that LVDAC-EMS is run in the hardware 
connected mode.

For detailed information on the DACI and the 4 Quadrant Power Supply and 
Dynamometer Controller, refer to the user guide for the system and each of 
these modules.

Install the DACI, AC 24V Power Supply, and 4 Quadrant Power Supply and 
Dynamometer Controller in the workstation.

5.

6. Make the connections to properly earth the equipment.

Refer to the user guide for the Electric Power Technology Training 
Equipment for information on how to properly earth the equipment.

Make sure that the main power switch of the 4 Quadrant Power Supply and 
Dynamometer Controller is set to the O (off) position. Then, connect its Power 
Input to an ac power outlet that is properly protected.

Make sure that the main power switch of the AC 24V Power Supply is set to the O 
(off) position. Then, connect the Power Input of the AC 24V Power Supply to an ac 
power outlet that is properly protected.

7.

Refer to the user guide for the Electric Power Technology Training 
Equipment for information on how to make sure that the ac power outlets 
to which you connect the equipment are properly protected.

8.

9.

10.

Connect the Power Input of the DACI to the Power Output of the AC 24V Power 
Supply.

Turn on (i.e., unlock) electric power at your workstation.

On the AC 24V Power Supply, set the main power switch to the I (on) position. 
Notice that the Power Input LED on the DACI lights up to indicate that power is 
supplied to the module.

Turn the 4 Quadrant Power Supply and Dynamometer Controller on by setting the 
Power Input switch to the I (on) position.

Connect the USB ports of the DACI and 4 Quadrant Power Supply and 
Dynamometer Controller to the USB ports of the host computer.

11.

If the DACI and/or the 4 Quadrant Power Supply and Dynamometer 
Controller is/are connected to the host computer for the first time, 
Windows will configure the new USB peripheral(s) with the pre-installed 
device driver(s).
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If LVDAC-EMS has been able to establish adequate connections with the DACI and the 
4 Quadrant Power Supply and Dynamometer Controller, the LVDAC-EMS Start-Up 
window indicates the modules, their serial number and their available function sets. 
The LVDAC-EMS Start-Up window then displays the names and the serial number of 
these modules, as well as the available function sets for each of these modules (see 
the following figure). The available function sets are activated on the DACI. The Start-
Up window shown on your computer screen may contain fewer function sets than 
shown in the following figure.

Turn the host computer on, then start the LVDAC-EMS software. This makes the 
LVDAC-EMS entry window appear for a few seconds, followed by the LVDAC-EMS 
Start-Up window. Meanwhile, LVDAC-EMS tries to establish connections with the 
DACI and the 4 Quadrant Power Supply and Dynamometer Controller.

12.

At this point, a message may appear on the host computer screen, 
indicating that you do not have the latest version of LVDAC-EMS installed 
on your computer. The software then needs to be updated before 
proceeding. In that case, perform the LVDAC-EMS installation procedure 
described previously.

If LVDAC-EMS has been unable to establish an adequate connection with the 
DACI, the LVDAC-EMS Start-Up window will display no information about the 
DACI. Similarly, if LVDAC-EMS has been unable to establish an adequate 
connection with the 4 Quadrant Power Supply and Dynamometer Controller, 
the LVDAC-EMS Start-Up window will display no information about this 
module. For example, the following figure shows the information displayed by 
the LVDAC-EMS Start-Up window when no connection has been established 
with the DACI, and an adequate connection has been established with the 4 
Quadrant Power Supply and Dynamometer Controller. In that case, perform 
the actions below to establish an adequate connection with both modules.

Try again to establish a connection between the software and the modules by 
clicking the Refresh button in the LVDAC-EMS Start-Up window. If LVDAC-EMS 
is still unable to establish a connection with one of the modules or with both 

Figure 1: LVDAC-EMS Start-Up window (example).
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of them, make sure that the modules are properly powered. Then, check the 
USB port connection between the modules and the host computer.

When an extension (second) DACI is used to implement certain advanced 
control functions, the LVDAC-EMS Start-Up window for this DACI looks like 
that shown in the following figure. As this figure shows, there is no function 
set displayed for an extension DACI.

Figure 3: LVDAC-EMS Start-Up window when an adequate connection is established with an extension DACI 
and an adequate connection is established with the 4 Quadrant Power Supply and Dynamometer 
Controller.

Figure 2: LVDAC-EMS Start-Up window when no connection is established with the DACI module and an 
adequate connection is established with the 4 Quadrant Power Supply and Dynamometer Controller.
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In the LVDAC-EMS Start-Up window, select the Network voltage and frequency 
that correspond to the voltage and frequency of your local ac power network, then 
click the OK button. This closes the LVDAC-EMS Start-Up window and brings up 
the LVDAC-EMS main window (see Figure 5).

13.

After closing the LVDAC-EMS Start-Up window, a dialog box like the one 
shown in the following figure may appear, prompting you to update the 
firmware in the DACI module or the 4 Quadrant Power Supply and 
Dynamometer Controller. In the following figure, for example, the 
Firmware Update Required dialog box prompts the user to update the 
firmware in the DACI. In that case, click the OK button in the Firmware 
Update Required dialog box. Then, follow the on-screen instructions to 
update the firmware in the module. (This will require you to power off both 
the DACI and the 4 Quadrant Power Supply and Dynamometer Controller).

Once the firmware is updated, power on both the DACI and the 4 Quadrant 
Power Supply and Dynamometer Controller. Then click on the Refresh 
button in the LVDAC-EMS Start-Up window. Make sure that both modules 
are detected, then repeat the above manipulation to access the LVDAC-
EMS main window.

The following figure shows the LVDAC-EMS main window. The indication 
"Hardware-Connected Mode" in the lower right-hand corner of this window 
indicates that LVDAC-EMS is properly connected to the DACI and the 4 Quadrant 
Power Supply and Dynamometer Controller. The Toolbar allows quick selection of 
an instrument or control function implemented with the DACI, or to open the Four 
Quadrant Dynamometer/Power Supply which provides access to the functions 
implemented with the 4 Quadrant Power Supply and Dynamometer Controller.

14.

Figure 4: LVDAC-EMS dialog box prompting you to update the firmware in the DACI.
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To change the language and units used in LVDAC-EMS, select Options from the 
Tools menu. This brings up the Options dialog box (see the following figure). In 
this box, select the desired language and units. Then click OK to apply the 
changes and close the Options dialog box.

15.

Figure 5: Main window of the LVDAC-EMS software.
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Starting a computer-based instrument

To start a computer-based instrument implemented with the DACI, select this 
instrument in the Instruments menu (Figure 7) of LVDAC-EMS, or click the 
corresponding button in the toolbar of LVDAC-EMS. The selected instrument will 
appear on the computer screen. For example, Figure 8  shows the window that 
appears when the Metering instrument is opened.

Whenever a computer-based instrument is started, the Data Acquisition and 
Control Settings panel displays in the right-hand section of the LVDAC-EMS main 
window. This panel allows you to modify the settings of the DACI analog inputs 
and digital input, as well as the range of the DACI voltage and current inputs.

16.

Figure 7: To start a computer-based instrument, select this instrument in the Instruments menu of LVDAC-
EMS or click the corresponding button in the toolbar of LVDAC-EMS.

Figure 6: To change the language and units used in LVDAC-EMS, access the Options dialog box by selecting 
Options from the Tools menu.
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To start a control function implemented with the DACI, select this function in the 
DACI menu (see the following figure) of LVDAC-EMS or click the corresponding 
button in the toolbar of LVDAC-EMS. The window of the selected control function 
will appear on the computer screen.

17.

When a control function is started, a control window appears, allowing you to 
select the function to implement, and adjust its parameters. For example, the 
following figure shows the control window that appears when the function Home 
Energy Production Control is selected.

18.

The Control Settings panel in the control window allows you to select the 
function to implement and set the parameters used for this function. In 
Figure 10, for example, the selected function is the Single Phase Stand-
Alone Inverter. Each parameter used for this function can be set by 
clicking on the parameter's name and entering the desired value or 
selecting the desired option in the field next to the parameter. The 

Figure 9: To start a control function implemented with the DACI, select this function in the DACI menu or 
click the corresponding button in the toolbar.

Figure 8: When the Metering instrument is started, the Metering window appears.
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bottom section of the Control Settings panel displays information on the 
function or parameter currently selected.

The bottom section of the control window contains a Start/Stop button 
used to turn the selected function on and off. The bottom section of the 
control window can also contain additional devices like meters for real-
time monitoring of parameter values, status LED indicators, control 
knobs for manual adjustment of parameter values, and others. This 
depends on the selected function.

Finally, the control window shows a diagram of the electrical circuit 
controlled by the function selected in the Control Settings panel. Clicking 
on the Show Connections button below this diagram brings up a 
Connections window showing the connections to perform on the modules 
when setting up the equipment for the selected function (see Figure 11). 
The connections shown in the Connections window correspond to those 
represented by black lines in the preceding figure.

Figure 10: The Home Energy Production Control window.
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Figure 11: Connections window showing the connections to perform on the modules to implement the 
function Single-Phase Stand-Alone Inverter.

For certain functions in which a complex controller is used, a Controller Diagram 
button can be present below the diagram of the electrical circuit shown in the control 
window. Clicking on this button brings up a Controller window showing the block 
diagram of the controller. The following figure shows an example.

Figure 12: Controller window showing the block diagram of the controller in the Three-Phase PWM 
Rectifier/Inverter Control function.

With advanced functions, like the Hydropower Generator (Dead Bus – Balanced Load) 
function available in the Synchronous Generator Control window, there can be several 
buttons below the diagram of the electrical circuit, as the following figure shows.

Clicking the Show AVR button brings up a window showing the block diagram 
of the Automatic Voltage Regulator of the hydropower generator.

Clicking the Show Speed Governor button brings up a window showing the 
block diagram of the Speed Governor of the hydropower generator.

Clicking the Show SCADA View button brings up a SCADA view of the 
hydropower generator, as the preceding figure shows. It contains additional 
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Figure 14: SCADA view of the Hydropower Generator (Dead Bus – Balanced Load) function.

Please refer to the user guides of the DACI and the 4 Quadrant Power Supply and 
Dynamometer Controller for more information on the instruments and functions 
available for these modules in LVDAC-EMS.

buttons used, among others, to start and stop the emulator and controller of 
the generator.

Figure 13: Synchronous Generator Control window, when the function Hydropower Generator (Dead Bus – 
Balanced Load) is selected.
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Learning Unit 2

Familiarization with the Metering Window and the Data Table

Setting up the equipment

 CAUTION

High voltages are present in this hands-on procedure. Do not make 
or modify any banana jack connections with the power on unless 
otherwise specified.

Install the 3AC 400V/DC 230V Power Supply, AC 24V Power Supply, Resistive Load 
module, and Data Acquisition and Control Interface in your workstation.

1.

Make the connections required to properly earth the equipment.2.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to properly earth 
the equipment.

Make sure the 3AC 400V/DC 230V Power Supply is turned off. Then, connect the 
terminals L1, L2, L3, and N of the 3AC 400V/DC 230V Power Supply to a three-
phase ac power outlet that is properly protected.

Make sure that the main power switch of the AC 24V Power Supply is set to 
the O (off ) position. Then, connect the Power Input of the AC 24V Power Supply to 
an ac power outlet that is properly protected.

3.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to make sure that 
the ac power outlets to which you connect the equipment are properly 
protected.

Connect the Power Input of the Data Acquisition and Control Interface to the 
Power Output of the AC 24V Power Supply.

4.

Turn on (i.e., unlock) electric power at your workstation.

On the AC 24V Power Supply, set the main power switch to the I (on) position. 
Notice that the Power Input LED on the Data Acquisition and Control Interface 
lights up to indicate that power is supplied to the module.

5.
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Figure 15: Simple resistive dc circuit.

Measuring electrical parameters using the Metering 
window

Connect the equipment as shown in the following figure. To implement resistor 
, connect the three resistor sections of the Resistive Load module in parallel.

Connect the USB port of the Data Acquisition and Control Interface to a USB port 
of the host computer.

On the Resistive Load module, set the resistance of resistor  to 1100 Ω.

6.

The red terminals of inputs U1 and I1 on the Data Acquisition and Control 
Interface correspond to the terminals marked with a plus (+) sign in the 
following figure.

Turn the host computer on, then start the LVDAC-EMS software.

In the LVDAC-EMS Start-Up window, make sure that the Data Acquisition and 
Control Interface is detected. Make sure that the Computer-Based Instrumentation 
function for the Data Acquisition and Control Interface is available. Select the 
network voltage and frequency that correspond to the voltage and frequency of 
your local ac power network, then click the OK button to close the LVDAC-EMS 
Start-Up window.

1.

If necessary, refer this section  of the present document for more 
information on how to start the LVDAC-EMS software.

Open the Metering window by choosing the corresponding command in the 
Instruments menu or by clicking the corresponding button in the toolbar of the 
LVDAC-EMS software.

2.

In the Metering window, make sure that the Extended Sampling Window is 
selected. To do so, go to the Options menu and select Acquisition Settings. Refer 
to the Menus/Options/Acquisition Settings help topic to learn more about this 
feature.

The Metering window is now ready for measuring parameters in the electrical 
circuit of Figure 15.

3.
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In the Metering window, set meter U1 as a dc voltmeter and meter I1 as a dc 
ammeter. Turn on meter PQS1 and set it as an active power (P) meter. Turn off 
meters U2, U3, U4, I2, I3, and I4. Refer to the Shortcuts to Meter Settings help 
topic to learn how to change the meter settings.

4.

In the Metering window, select the continuous refresh mode. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar. Refer to the Menus/View help topic to obtain additional information 
on the single and continuous refresh modes of the Metering window.

Turn the 3AC 400V/DC 230V Power Supply on and observe the following:

Decrease the value of resistor  by closing resistor switches on the Resistive 
Load module. While doing this, observe that the values displayed by meters U1, 
I1, and PQS1 change to reflect the decrease in value of resistor .  This is 
because the meter displays are refreshed at regular time intervals when the 
continuous refresh mode is selected.

5.

Meter U1 displays the dc source voltage.

Meter I1 displays the dc current flowing in the circuit.

Meter PQS1 displays the active power dissipated in resistor .

In the Metering window, select the single refresh mode. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar.

On the Resistive Load module, set the resistance of resistor  to the value shown 
in Figure 15. While doing this, observe that the values indicated by meters U1, I1, 
and PQS1 do not change to reflect the change in the value of resistor . This is 
because the meter displays are not refreshed at regular time intervals when the 
single refresh mode is selected.

In the Metering window, refresh the display. To do so, choose the Single Refresh 
command in the View menu or click the corresponding button in the toolbar. 
Observe that this causes the meters to be refreshed so that the values indicated 
reflect the change in the value of resistor .

6.

Turn the 3AC 400V/DC 230V Power Supply off.

Replace the fixed-voltage dc power source with a fixed-voltage ac power source, 
as shown in the following figure.

On the Resistive Load module, make sure that the resistance of resistor  is set 
to 1100 Ω.

7.



Learning Unit 2 – Familiarization with the Metering Window and the Data Table

24 © Festo Didactic

Figure 16: Simple resistive ac circuit.

Recording data in the Data Table

In the Metering window, set meter U1 as an ac voltmeter and meter I1 as an ac 
ammeter. You can refer to the Shortcuts to Meter Settings help topic to know how 
to change the meter settings.

In the Metering window, open the Meter Settings dialog box. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar.

Set programmable meter M5 as a frequency meter (function f (U1)) and 
programmable meter M11 as an ohmmeter (impedance function RXZ (U1, I1)), 
turn on these meters and close the Meter Settings dialog box. Refer to the Menus/
View/Meter Settings help topic to obtain additional information on the Meter 
Settings dialog box.

8.

In the Metering window, select the continuous refresh mode.

Turn on the 3AC 400V/DC 230V Power Supply. Change the switch settings on the 
Resistive Load module so that the resistance value decreases by small steps. The 
ac source current (displayed by ammeter I1) should increase by small steps. While 
doing this, observe that the meters refresh in a continuous way to reflect the 
variation of the measured parameters. Also observe that programmable meters 
M5 and M11 indicate the ac power network frequency and the value of resistor 

, respectively.

On the Resistive Load module, set the resistance of resistor  to 1100 Ω.

9.

Open the Data Table window. To do so, choose the corresponding command in the 
Tools menu or click the corresponding button in the toolbar of the LVDAC-EMS 
software. Refer to the Overview of the Data Table help topic to obtain additional 
information about the Data Table window.

1.

In the Data Table window, record the values indicated by the meters in the 
Metering window. To do so, choose Record Data in the Edit menu or click the 
corresponding button in the toolbar.

The Record Settings dialog box should appear. This box allows you to select the 
parameters whose values are to be recorded in the Data Table window. The 
parameters measured by the meters that are turned on in the Metering window 
should be selected in the Record Settings dialog box (a check mark appears 
beside each parameter selected). In the present case, parameters U1, I1, 
PQS1(U1, I1), f(U1), and RXZ(U1, I1) should be selected. Refer to the Menus/

2.
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Plotting a graph with the recorded data

Measuring mechanical parameters using the Metering 
window

Options/Record Settings help topic to obtain additional information about data 
recording and the Record Settings dialog box.

Click the OK button in the Record Settings dialog box. This closes the dialog box 
and records the values indicated by the selected meters in the Metering window in 
the first row of the Data Table window.

On the Resistive Load module, change the switch settings so that the resistance of 
resistor  decreases to 210 Ω in about 10 steps. For each resistance value, 
record in the Data Table window the values displayed by the meters in the 
Metering window. Observe that a new row in the Data Table window fills up with 
data whenever a Record Data command is performed.

Turn the 3AC 400V/DC 230V Power Supply off.

3.

In the Data Table window, open the Graph window by choosing the corresponding 
command in the View menu or by clicking the corresponding button in the toolbar. 
Refer to the Overview of the Graph help topic to obtain general information about 
the Graph window of the Data Table.

1.

In the Graph window, plot a Graph of the current flowing through resistor  as a 
function of the resistance of resistor . To do so, select impedance RXZ(U1, I1) as 
the X-axis parameter and current I1 as the vertical-axis first parameter (1-Y). 
Observe that a curve showing the variation of current as a function of resistance 
appears in the Graph window when both parameters are selected. Refer to the 
Overview of the Graph help topics to obtain additional information about the 
Graph window of the Data Table.

2.

Close the Graph window.

Close the Data Table window without saving the recorded data.

3.

Install the 4 Quadrant Power Supply and Dynamometer Controller in your 
workstation.

Place the 4 Quadrant Dynamometer Motor on a horizontal surface near the 
workstation.

Observe that there is an identification (ID) label on the 4 Quadrant Power Supply 
and Dynamometer Controller as well as on the 4 Quadrant Dynamometer Motor. 
For optimal operation, the ID of the 4 Quadrant Dynamometer Motor should be 
the same as the ID of the 4 Quadrant Power Supply and Dynamometer Controller.

1.

Make sure that the protective guard is installed on the 4 Quadrant Dynamometer 
Motor. This guard is intended to avoid possible injuries resulting from accidental 

2.
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contact with the shaft of the 4 Quadrant Dynamometer Motor. The operation of 
the 4 Quadrant Dynamometer Motor is prevented when the guard is not installed.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on the installation of the 
protective guard on the 4 Quadrant Dynamometer Motor.

Make the connections required to properly earth the 4 Quadrant Dynamometer 
Motor and the 4 Quadrant Power Supply and Dynamometer Controller.

3.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to properly earth 
the equipment.

Make sure that the main power switch of the 4 Quadrant Power Supply and 
Dynamometer Controller is set to the O (off ) position. Then, connect its Power 
Input to an ac power outlet that is properly protected.

4.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to make sure that 
the ac power outlets to which you connect the equipment are properly 
protected.

Connect the cable on the 4 Quadrant Dynamometer Motor to the 4 Quadrant 
Power Supply and Dynamometer Controller.

5.

Connect the T and n Analog Outputs of the 4 Quadrant Power Supply and 
Dynamometer Controller to the 7/T (torque) and 8/n (speed) Analog Inputs of the 
DACI module, respectively. Connect one of the analog common terminals of the 4 
Quadrant Power Supply and Dynamometer Controller to one of the analog 
common terminals of the DACI. These connections are required to measure torque 
and speed.

Turn the 4 Quadrant Power Supply and Dynamometer Controller on by setting the 
Power Input switch to the I (on) position.

On the 4 Quadrant Power Supply and Dynamometer Controller, set the Operating 
Mode switch to Dynamometer. This setting allows the module to operate as a 
dynamometer or a prime mover depending on the selected function.

On the 4 Quadrant Power Supply and Dynamometer Controller, select the 
Clockwise Prime Mover function. To do so, press the Function button until the 
function indicated in the module display is CW Prime Mover/Brake.

6.

In the Data Acquisition and Control Settings window of LVDAC-EMS, set parameter 
AI-7 Type of Parameter to Corr.Torque (N·m).

In the Metering window, turn all meters off then turn the torque (AI-7/T) and 
speed (AI-8/n) meters on.

On the 4 Quadrant Power Supply and Dynamometer Controller, set the speed 
command of the prime mover to about 1500 r/min using the Command button. 

7.
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The value of the speed command is indicated in the module display. Notice that 
the speed command shown in the module display is blinking.

On the 4 Quadrant Power Supply and Dynamometer Controller, start the prime 
mover. To do so, momentarily depress the Start/Stop button. The prime mover 
should start to rotate immediately. Notice that the speed value in the module 
display is no longer blinking. This indicates that the speed shown is now the 
actual rotation speed of the prime mover.

On the 4 Quadrant Power Supply and Dynamometer Controller, press and hold the 
Function button for 3 seconds to have uncorrected torque values on the module 
display. The indication "NC" appears next to the function name on the module 
display when uncorrected torque values are indicated.

In the Metering window, make sure that the continuous refresh mode is selected. 
Observe that meter AI 8/n indicates the rotation speed of the prime mover. Also, 
meter AI-7/T indicates the torque produced by the prime mover to overcome the 
torque that opposes rotation. Friction is the main cause for this torque.

By default, the torque correction function is enabled in the 4 Quadrant 
Power Supply and Dynamometer Controller. To disable this function press 
and hold the Function button for 3 seconds. To enable back the torque 
correction function, press the Function button once again for 3 seconds. 
The status (enabled or disabled) of the torque correction function stays 
unchanged when another function is selected with the Function button.

On the 4 Quadrant Power Supply and Dynamometer Controller, stop the prime 
mover by momentarily depressing the Start/Stop button. Observe that the torque 
and speed indicated by meters AI-7/T and AI 8/n, respectively, decrease to zero.

In the Metering window, select the single refresh mode.

8.

Close the Metering window.9.

Close LVDAC-EMS.10.

Turn the AC 24V Power Supply off.11.

Turn the 4 Quadrant Power Supply and Dynamometer Controller off.12.

Turn electric power off at your workstation. Remove all circuit connections, 
finishing with the equipment earthing connections. Return all equipment to its 
storage location.

13.
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Learning Unit 3

Familiarization with the Oscilloscope

Setting up the equipment

 CAUTION

High voltages are present in this hands-on procedure. Do not make 
or modify any banana jack connections with the power on unless 
otherwise specified.

Install the 3AC 400V/DC 230V Power Supply, AC 24V Power Supply, Resistive Load 
module, Inductive Load module, and Data Acquisition and Control Interface in 
your workstation.

1.

Make the connections required to properly earth the equipment.2.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to properly earth 
the equipment.

Make sure the 3AC 400V/DC 230V Power Supply is turned off. Then, connect 
terminals L1, L2, L3, and N of the 3AC 400V/DC 230V Power Supply to a three-
phase ac power outlet that is properly protected.

Make sure that the main power switch of the AC 24V Power Supply is set to 
the O (off ) position. Then, connect the Power Input of the AC 24V Power Supply to 
an ac power outlet that is properly protected.

3.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to make sure that 
the ac power outlets to which you connect the equipment are properly 
protected.

Connect the Power Input of the Data Acquisition and Control Interface (DACI) 
module to the Power Output of the AC 24V Power Supply.

4.

Turn on (i.e., unlock) electric power at your workstation.5.
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Figure 17: Simple resistive-inductive circuit.

Horizontal, Vertical, and Trigger settings

On the AC 24V Power Supply, set the main power switch to the I (on) position. 
Notice that the Power Input LED on the DACI module lights up to indicate that 
power is supplied to the module.

Connect the equipment as shown in the following figure.

Connect the USB port of the Data Acquisition and Control Interface to a USB port 
of the host computer.

On the Resistive Load module, set the resistance of resistor  to 1100 Ω.

On the Inductive Load module, set the inductance of inductor  to 3.5 H.

Turn the 3AC 400V/DC 230V Power Supply on.

6.

The red terminals of inputs U1 and I1 on the DACI module correspond to 
the terminals marked with a plus (+) sign in the following figure

Turn the host computer on, then start the LVDAC-EMS software.

In the LVDAC-EMS Start-Up window, make sure that the Data Acquisition and 
Control Interface is detected. Make sure that the Computer-Based Instrumentation 
function for the Data Acquisition and Control Interface is available. Select the 
network voltage and frequency that correspond to the voltage and frequency of 
your local ac power network, then click the OK button to close the LVDAC-EMS 
Start-Up window.

1.

If necessary, refer to this section  of the present document for more 
information on how to start the LVDAC-EMS software.

Start the Oscilloscope. To do so, choose the corresponding command in the 
Instruments menu or click the corresponding button in the toolbar of the 
LVDAC‑EMS software.

2.

Set the Oscilloscope according to the settings provided in the following table.

Refer to the Oscilloscope Settings help topic to know how to do these settings.

3.
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Parameters Settings

Channel 1

Input (observed parameter) U1

Scale 200 V/div

Invert Off

Coupling DC

Channel 2

Input (observed parameter) I1

Scale 0.2 A/div

Invert Off

Coupling DC

Time Base 2 ms/div

Trigger

Source Ch 1

Level 0

Slope Rising

Table 1: Oscilloscope settings.

On the Oscilloscope, select the continuous refresh mode. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar. Refer to the Menus/View help topic to obtain additional information 
on the single and continuous refresh modes of the Oscilloscope screen.

The waveforms of the ac source voltage (U1) and the current flowing in the 
circuit (I1) should be displayed on the Oscilloscope screen. Observe that each 
waveform is displayed using a different color.

Also, observe that the ac source voltage goes through zero on a positive slope at 
the beginning of the trace. This corresponds to the trigger settings of the 
Oscilloscope. Note that you can move the horizontal position of the trigger point. 
Refer to the Oscilloscope Settings/Trigger help topic to know how to move the 
horizontal position of the trigger point.

4.

For more information about the trigger operation, refer to the Technical 
Information about Trigger Operation help topic.

On the Oscilloscope, change the vertical position of the traces so that the ac 
source voltage waveform (channel 1 trace) and the circuit current 
waveform (channel 2 trace) are located in the middle of the upper and lower parts 

5.



Learning Unit 3 – Familiarization with the Oscilloscope

32 © Festo Didactic

Parameters Settings

Channel 3

Input (observed parameter) U1, I1

Scale 20 W/div

Invert Off

Coupling DC

Continuous and Single Refresh modes

of the Oscilloscope screen, respectively. Refer to the Oscilloscope Settings/
Channel 1 to 8 help topic to know how to change the vertical position of the 
traces on the Oscilloscope screen.

Set a third channel (channel 3) of the Oscilloscope according to the settings 
provided in the following table.

Observe that a third sinusoidal waveform appears on the Oscilloscope screen. 
This waveform shows the power delivered by the ac power source. It is obtained 
from the voltage and current measured at inputs U1 and I1 of the DACI module.

6.

Table 2: Additional Oscilloscope settings.

On the Resistive Load module, close switches to increase the resistance of resistor 
 by steps. While doing this, observe that the waveforms on the Oscilloscope 

screen change whenever the resistance of resistor  decreases. This is because 
the Oscilloscope screen is refreshed at regular intervals when the continuous 
refresh mode is selected.

1.

On the Oscilloscope, select the single refresh mode. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar. Observe that the last waveforms acquired remain displayed on the 
Oscilloscope screen.

On the Resistive Load module, open switches to set the resistance of resistor 
to 4400 Ω. While doing this, observe that the waveforms on the Oscilloscope 
screen do not change. The Oscilloscope screen is not refreshed at regular intervals 
when the single refresh mode is selected.

On the Oscilloscope, manually refresh the display. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar. Observe that this causes the waveforms to be refreshed. Notice that 
the height of the waveforms of the current and power on the Oscilloscope screen 
are relatively low because the resistance of resistor  is now 4400 Ω.

On the Oscilloscope, select the continuous refresh mode.

2.
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Auto Scale Function

Waveform Data Section

On the Oscilloscope, select the Auto Scale function from the Options menu. 
Observe that the scales of channels 1 to 3 are automatically readjusted according 
to the amplitude of the observed parameters. Refer to the Menus/Options help 
topic to obtain additional information about the Auto Scale function.

1.

On the Resistive Load module, make the necessary switch settings so that the 
resistance of resistor  is 1100 Ω.

On the Oscilloscope, use the Auto Scale function to automatically readjust the 
scales of channels 1 to 3.

2.

Observe that the Channel Data section, located under the Oscilloscope screen, 
indicates the RMS value, average value, and frequency of the observed 
parameters.

1.

Refer to the Oscilloscope Settings/Channel Data Table help topic to obtain 
additional information on the data provided in the present section.

2.

On the Oscilloscope, display the vertical cursors by clicking the corresponding 
button in the toolbar. Observe that two vertical lines appear on the Oscilloscope 
screen. These lines are the vertical cursors. Each vertical cursor can be moved 
horizontally so that it is aligned with a particular point on the observed 
waveforms. Also, observe that the nature of the information in the Channel Data 
section of the Oscilloscope changes to indicate values related to the cursors. 
Refer to the Menus/Tools help topic to know how to display and move the cursors.

3.

On the Oscilloscope, slowly move cursor 1 so that it is located two divisions from 
the left-hand side of the screen. While doing this, observe that the Cur 1 column in 
the Channel Data section indicates the position in time of cursor 1 and the 
instantaneous value of each parameter at the intersection of cursor 1 and the 
corresponding waveform.

Move cursor 2 so that it is located six divisions from the left-hand side of the 
Oscilloscope screen. Observe that the position in time of cursor 2 and the 
instantaneous value of each parameter at the intersection of cursor 2 are 
indicated in column Cur 2 of the Channel Data section.

4.

Observe that the Diff column in the Channel Data section indicates the difference 
between the instantaneous values of each parameter measured with the two 
cursors as well as the time interval between these cursors. Refer to the 
Oscilloscope Settings/Channel Data Table help topic to obtain all information 
about the Channel Data section and the cursors.

Note that any data in the Channel Data section can be recorded in the Data Table. 
Refer to the Menus/Edit and Menus/Options help topics related to the Data Table 

5.
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Storing waveforms to memory

View waveforms from memory

to know how to record data. The Data Table window allows graphs to be plotted 
quickly and easily using the recorded data.

On the Oscilloscope, remove the cursors.

On the Oscilloscope, select the single refresh mode. The last waveforms acquired 
remain displayed on the Oscilloscope screen.

1.

On the Oscilloscope, store the displayed waveforms in memory 1 by clicking the 
M1 button on the toolbar. Refer to the Menus/Tools help topic to know how to 
store waveforms in memory.

2.

On the Oscilloscope, select the continuous refresh mode.

Turn the 3AC 400V/DC 230V Power Supply off.

Short-circuit resistor  using a banana plug wire.

Turn the 3AC 400V/DC 230V Power Supply on. Observe that new waveforms 
appear on the Oscilloscope screen. Use the Auto Scale function to automatically 
readjust the scales of channels 1 to 3.

On the Oscilloscope, select the single refresh mode to "freeze" the displayed 
waveforms.

1.

Display the waveforms stored in memory 1 a little earlier in this procedure by 
clicking the corresponding button in the toolbar. This allows you to easily compare 
the waveforms obtained before and after resistor  has been short-circuited. 
Refer to the Menus/Tools help topic to know how to view waveforms from 
memory.

2.

Close the Oscilloscope.3.

Close LVDAC-EMS.4.

Turn the AC 24V Power Supply off.5.

Turn the 3AC 400V/DC 230V Power Supply off.6.

Turn electric power off at your workstation. Remove all circuit connections, 
finishing with the equipment earthing connections. Return all equipment to its 
storage location.

7.
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Learning Unit 4

Familiarization with the Phasor Analyzer

Setting up the equipment

 CAUTION

High voltages are present in this hands-on procedure. Do not make 
or modify any banana jack connections with the power on unless 
otherwise specified.

Install the 3AC 400V/DC 230V Power Supply, AC 24V Power Supply, Resistive Load 
module, Inductive Load module, and Data Acquisition and Control Interface in 
your workstation.

1.

Make the connections required to properly earth the equipment.2.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to properly earth 
the equipment.

Make sure the 3AC 400V/DC 230V Power Supply is turned off. Then, connect 
terminals L1, L2, L3, and N of the 3AC 400V/DC 230V Power Supply to a three-
phase ac power outlet that is properly protected.

Make sure that the main power switch of the AC 24V Power Supply is set to 
the O (off ) position. Then, connect the Power Input of the AC 24V Power Supply to 
an ac power outlet that is properly protected.

3.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to make sure that 
the ac power outlets to which you connect the equipment are properly 
protected.

Connect the Power Input of the Data Acquisition and Control Interface to the 
Power Output of the AC 24V Power Supply.

4.

Turn on (i.e., unlock) electric power at your workstation.5.
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Figure 18: Simple resistive-inductive circuit.

Phasor selection and scale settings

On the AC 24V Power Supply, set the main power switch to the I (on) position. 
Notice that the Power Input LED on the DACI module lights up to indicate that 
power is supplied to the module.

Connect the equipment as shown in the following figure.

Connect the USB port of the Data Acquisition and Control Interface to a USB port 
of the host computer.

On the Resistive Load module, set the resistance of resistor  to 1100 Ω.

On the Inductive Load module, set the inductance of inductor  to 3.5 H.

Turn the 3AC 400V/DC 230V Power Supply on.

6.

The red terminals of inputs U1, U2, U3, and I1 on the DACI module 
correspond to the terminals marked with a plus (+) sign in the following 
figure

Turn the host computer on, then start the LVDAC-EMS software.

In the LVDAC-EMS Start-Up window, make sure that the Data Acquisition and 
Control Interface is detected. Make sure that the Computer-Based Instrumentation 
function for the Data Acquisition and Control Interface is available. Select the 
network voltage and frequency that correspond to the voltage and frequency of 
your local ac power network, then click the OK button to close the LVDAC-EMS 
Start-Up window.

1.

If necessary, refer to this section  of the present document for more 
information on how to start the LVDAC-EMS software.

Start the Phasor Analyzer. To do so, choose the corresponding command in the 
Instruments menu or click the corresponding button in the toolbar of the LVDAC-
EMS software.

2.

Set the Phasor Analyzer according to the settings provided in the following table.3.
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Parameters Setting

Voltage scale 100 V/div

Current scale 0.1 A/div

Reference phasor selection

These settings determine the voltage and current intervals between each circular 
division on the Phasor Analyzer display. Refer to the Phasor Analyzer Settings help 
topic to know how to do these settings.

Table 3: Phasor Analyzer settings.

On the Phasor Analyzer, make sure that only voltage U1 (source voltage) is 
selected. Refer to the Phasor Analyzer Settings help topic to know how to select 
the voltages and currents whose phasors are to be displayed.

4.

On the Phasor Analyzer, select the continuous refresh mode. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar. Refer to the Menus/View help topic to obtain additional information 
on the single and continuous refresh modes of the Phasor Analyzer display.

Observe that a line appears on the Phasor Analyzer display. This line is a phasor 
that represents voltage U1 (source voltage). The length of phasor U1 corresponds 
to the RMS value of the ac component of the source voltage.

5.

On the Phasor Analyzer, select voltage U1 (source voltage) as the reference 
phasor. Refer to the Phasor Analyzer Settings help topic to know how to do this 
selection.

Observe that phasor U1 appears at an angle of 0° on the Phasor Analyzer display. 
This is because the phasor related to voltage U1 has been selected as the 
reference phasor. The reference phasor is always displayed at an angle of 0° on 
the Phasor Analyzer display. All other phasors are positioned on the Phasor 
Analyzer display with respect to the reference phasor.

1.

On the Phasor Analyzer, select current I1 (circuit current). Observe that another 
phasor appears at an angle of about −42° on the Phasor Analyzer display. This 
phasor represents the current (I1) flowing in the resistive-inductive circuit. The 
length of phasor I1 corresponds to the RMS value of the ac component of the 
circuit current. Since the phasors rotate counterclockwise on the Phasor Analyzer 
display, the displayed phasors clearly demonstrate that current lags voltage in a 
resistive-inductive circuit.

2.

On the Phasor Analyzer, select current I1 (circuit current) as the reference phasor. 
Observe that the position of phasors U1 and I1 on the Phasor Analyzer display 
changed. Phasor I1 is displayed at an angle of 0° because it is selected as the 
reference phasor. Consequently, phasor U1 is displayed at an angle of about 42°.

3.
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Observing phasors

Phasor data section

On the Resistive Load module, close switches to decrease the resistance of 
resistor  by steps. While doing this, observe that both the length of 
phasor I1 (circuit current value) and the angular interval between phasors I1 and 
U1 (phase shift between the circuit current and source voltage) increase to reflect 
the change in the circuit impedance.

1.

On the Phasor Analyzer, select voltages U2 (voltage across resistor )
and U3 (voltage across inductor ).

Observe that the phasor related to voltage U2 appears at an angle of 0° because 
the voltage across a resistor is in phase with the circuit current (phasor I1).

Observe that the phasor related to voltage U3 appears at an angle of about 90° 
because the voltage across an inductor leads the circuit current (phasor I1) 
by 90°.

2.

Observe that the Phasor Data Table, located under the Phasor Analyzer display, 
indicates the RMS value of the ac component of the voltage or current, phase 
angle, and frequency associated with each of the displayed phasors.

Refer to the Phasor Data Table help topic to obtain additional information on the 
data provided in this section.

1.

On the Resistive Load module, set the resistance of resistor  to the value shown 
in Figure 18. While doing this, observe that the values in the Phasor Data Table 
change accordingly to reflect the change in the circuit impedance.

2.

On the Phasor Analyzer, select the single refresh mode by choosing the 
corresponding command in the View menu or by clicking the corresponding 
button in the toolbar.

3.

Close the Phasor Analyzer.4.

Close LVDAC-EMS.5.

Turn the AC 24V Power Supply off.6.

Turn the 3AC 400V/DC 230V Power Supply off.7.

Turn electric power off at your workstation. Remove all circuit connections, 
finishing with the equipment earthing connections. Return all equipment to its 
storage location.

8.
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Learning Unit 5

Familiarization with the Harmonic Analyzer

Setting up the equipment

 CAUTION

High voltages are present in this hands-on procedure. Do not make 
or modify any banana jack connections with the power on unless 
otherwise specified.

Install the 3AC 400V/DC 230V Power Supply, AC 24V Power Supply, Resistive Load 
module, and Data Acquisition and Control Interface in your workstation.

1.

Make the connections required to properly earth the equipment.2.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to properly earth 
the equipment.

Make sure the 3AC 400V/DC 230V Power Supply is turned off. Then, connect 
terminals L1, L2, L3, and N of the 3AC 400V/DC 230V Power Supply to a three-
phase ac power outlet that is properly protected.

Make sure that the main power switch of the AC 24V Power Supply is set to 
the O (off ) position. Then, connect the Power Input of the AC 24V Power Supply to 
an ac power outlet that is properly protected.

3.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to make sure that 
the ac power outlets to which you connect the equipment are properly 
protected.

Connect the Power Input of the Data Acquisition and Control Interface to the 
Power Output of the AC 24V Power Supply.

4.

Turn on (i.e., unlock) electric power at your workstation.

On the AC 24V Power Supply, set the main power switch to the I (on) position. 
Notice that the Power Input LED on the Data Acquisition and Control Interface 
lights up to indicate that power is supplied to the module.

5.
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Figure 19: Circuit used to measure the harmonic contents at the ac output of the 3AC 400V/DC 230V Power 
Supply.

Harmonic Analyzer Settings

Connect the equipment as shown in the following figure.

Connect the USB port of the Data Acquisition and Control Interface to a USB port 
of the host computer.

On the Resistive Load module, set the resistance of resistor  to 1100 Ω.

Turn the 3AC 400V/DC 230V Power Supply on.

6.

The red terminal of input U1 on the Data Acquisition and Control Interface 
corresponds to the terminal marked with a plus (+) sign in the following 
figure.

Turn the host computer on, then start the LVDAC-EMS software.

In the LVDAC-EMS Start-Up window, make sure that the Data Acquisition and 
Control Interface is detected. Make sure that the Computer-Based Instrumentation 
function for the Data Acquisition and Control Interface is available. Select the 
network voltage and frequency that correspond to the voltage and frequency of 
your local ac power network, then click the OK button to close the LVDAC-EMS 
Start-Up window.

1.

If necessary, refer to this section  of the present document for more 
information on how to start the LVDAC-EMS software.

Start the Harmonic Analyzer. To do so, choose the corresponding command in the 
Instruments menu or click the corresponding button in the toolbar of the 
LVDAC‑EMS software.

2.

Set the Harmonic Analyzer according to the settings provided in the following 
table.

Refer to the Harmonic Analyzer Settings help topic to know how to do these 
settings.

Observe that the horizontal axis (frequency axis) of the Harmonic Analyzer display 
is set to display the first 40 harmonics of the selected input parameter (voltage 
U1, i.e., the ac source voltage).

3.
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Parameters Settings

Input U1

Scale type % of 1f

Scale setting 10%/div

Fundamental frequency type Network

Number of harmonics 40 Harmonics

Observation of harmonic contents

Observe that the vertical scale of the Harmonic Analyzer display is graduated in 
percentage of the fundamental frequency component (% of 1f ) with a progression 
of 10% per division.

Table 4: Harmonic Analyzer settings.

On the Harmonic Analyzer, select the continuous refresh mode. To do so, choose 
the corresponding command in the View menu or click the corresponding button 
in the toolbar. Refer to the Menus/View help topic to obtain additional 
information on the single and continuous refresh modes of the Harmonic Analyzer 
display.

Observe that a vertical bar appears in the Harmonic Analyzer display. This bar 
corresponds to the fundamental frequency component of the ac source voltage, 
that is, the component at the ac power network frequency.

1.

On the Harmonic Analyzer, increase the sensitivity (by decreasing the Scale 
setting) step by step. While doing this, observe that a few other harmonic 
components gradually appear on the Harmonic Analyzer display. These 
components should have fairly low levels because the waveform of the ac power 
network voltage is close to that of a pure sine wave.

2.

Observe that the Levels and Distortion section of the Harmonic Analyzer indicates 
the value of the dc component and the first forty harmonics of the selected input 
parameter (voltage U1, i.e., the ac source voltage).

Also observe that each value is expressed as a percentage of the fundamental 
frequency component, as in the Harmonic Analyzer display. You can refer to the 
Harmonic Analyzer Settings help topic to obtain additional information about the 
Levels and Distortion section.

3.

Observe that the THD and THD1 Distortion displays indicate the total harmonic 
distortion (THD) in the selected input parameter (voltage U1). Both values should 
be low and almost identical because THD in the ac power network voltage is low in 
general. Refer to the Menus/View and Technical Information about the Harmonic 

4.
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Cursors

Analyzer help topics to obtain additional information about the nature of the 
values indicated by the THD and THD1 Distortion displays.

On the Harmonic Analyzer, set the number of harmonics to 20.

Observe that the Harmonic Analyzer now displays only the first 20 harmonics of 
the selected input parameter (voltage U1).

5.

On the Harmonic Analyzer, display the vertical cursors using the Show menu of 
the Harmonic Analyzer Settings. Observe that two vertical lines appear on the 
Harmonic Analyzer display. These lines are the vertical cursors. Each vertical 
cursor can be moved horizontally so that it is aligned with a particular harmonic 
component. Refer to the Cursors help topic to know how to display and move the 
vertical cursors.

1.

On the Harmonic Analyzer, align cursor 1 with the first harmonic (fundamental 
frequency component), and cursor 2 with the third harmonic.

Observe that column Cur 1 in the Cursors section, located under the Harmonic 
Analyzer display, indicates the number, frequency, and level of the harmonic on 
which cursor 1 is aligned. Column Cur 2 provides the same information about the 
harmonic on which cursor 2 is aligned.

You can refer to the Cursors help topic to obtain additional information about the 
Cursors section.

Note that any value indicated in the Cursors section, Levels and Distortion section 
of the Harmonic Analyzer can be recorded in the Data Table. Refer to the Menus/
Edits and Menus/Options help topics related to the Data Table to know how to 
record data. The Data Table window allows graphs to be plotted quickly and easily 
using the recorded data.

2.

On the Harmonic Analyzer, set the Scale Type to V (voltage).

Observe that the vertical scale of the Harmonic Analyzer is graduated in 
volts (RMS values). Observe that all values in the Levels and Distortion section 
and the Level data fields of the Cursors section are also expressed in volts (RMS 
values).

3.

On the Harmonic Analyzer, remove the vertical cursors. Note that horizontal 
cursors similar to the vertical cursors are also available. Refer to the Cursors help 
topic to know how to display and move the horizontal cursors.

4.

On the Harmonic Analyzer, select the single refresh mode. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar.

5.

Close the Harmonic Analyzer.6.
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Close LVDAC-EMS.7.

Turn the AC 24V Power Supply off.8.

Turn the 3AC 400V/DC 230V Power Supply off.9.

Turn electric power off at your workstation. Remove all circuit connections, 
finishing with the equipment earthing connections. Return all equipment to its 
storage location.

10.
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Learning Unit 6

Measuring Three-Phase Power Using the Metering Window

Setting up the equipment

Install the 3AC 400V/DC 230V Power Supply, AC 24V Power Supply, Resistive Load 
module, and Data Acquisition and Control Interface in your workstation.

1.

Make the connections required to properly earth the equipment.2.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to properly earth 
the equipment.

Make sure the 3AC 400V/DC 230V Power Supply is turned off. Then, connect 
terminals L1, L2, L3, and N of the 3AC 400V/DC 230V Power Supply to a three-
phase ac power outlet that is properly protected.

Make sure that the main power switch of the AC 24V Power Supply is set to 
the O (off ) position. Then, connect the Power Input of the AC 24V Power Supply to 
an ac power outlet that is properly protected.

3.

Refer to guide Safety Instructions and Commissioning of the Electric Power 
Technology Training Equipment for information on how to make sure that 
the ac power outlets to which you connect the equipment are properly 
protected.

Connect the Power Input of the Data Acquisition and Control Interface to the 
Power Output of the AC 24V Power Supply.

4.

Turn on (i.e., unlock) electric power at your workstation.

On the AC 24V Power Supply, set the main power switch to the I (on) position. 
Notice that the Power Input LED on the Data Acquisition and Control Interface 
lights up to indicate that power is supplied to the module.

5.

Connect the equipment as shown in the following figure.6.

The red terminals of inputs U1 and I1 on the Data Acquisition and Control 
Interface correspond to the terminals marked with a plus (+) sign in the 
following figure.
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Figure 20: Data Acquisition and Control Interface connections used to measure power in balanced three-
phase circuits.

Measuring power in balanced three-phase circuits using the 
Metering window

Connect the USB port of the Data Acquisition and Control Interface to a USB port 
of the host computer.

On the Resistive Load module, set the resistance of resistors , ,  and 
to 1100 Ω.

Turn the host computer on, then start the LVDAC-EMS software.

In the LVDAC-EMS Start-Up window, make sure that the Data Acquisition and 
Control Interface is detected. Make sure that the Computer-Based Instrumentation 
function for the Data Acquisition and Control Interface is available. Select the 
network voltage and frequency that correspond to the voltage and frequency of 
your local ac power network, then click the OK button to close the LVDAC-EMS 
Start-Up window.

1.

If necessary, refer to this section  of the present document for more 
information on how to start the LVDAC-EMS software.

Open the Metering window by choosing the corresponding command in the 
Instruments menu or by clicking the corresponding button in the toolbar of the 
LVDAC-EMS software.

2.

In the Metering window, make sure that the Extended Sampling Window is 
selected. To do so, go to the Options menu and select Acquisition Settings. Refer 
to the Menus/Options/Acquisition Settings help topic to learn more about this 
feature.

The Metering window is now ready for measuring parameters in the three-phase 
circuit of Figure 20.

3.
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In the Metering window, set meter U1 as an ac voltmeter and meter I1 as an ac 
ammeter. Turn off meters U2, U3, U4, I2, I3, and I4. Refer to the Shortcuts to Meter 
Settings help topic to learn how to change the meter settings fast.

4.

In the Metering window, select the continuous refresh mode by choosing the 
corresponding command in the View menu or by clicking the corresponding 
button in the toolbar. If necessary, refer to the Menus/View help topic to obtain 
additional information on the single and continuous refresh modes of the 
Metering window.

5.

Turn on the 3AC 400V/DC 230V Power Supply.

Record the line-to-line voltage (displayed by voltmeter U1) and line 
current (displayed by ammeter I1) in the following blank spaces.

Line-to-line voltage ( ):  V

Line current ( ):  A

6.

Using the measured parameters and the following equation, calculate the active 
power dissipated in the circuit.

Active power ( ):  W

7.

 is equal to 1 because circuit load is resistive only.

In the Metering window, open the Meter Settings dialog box by choosing the 
corresponding command in the View menu or by clicking the corresponding 
button in the toolbar.

Set programmable meter M5 as a three-phase active power meter by selecting 
power function PQS1 (U1, I1) 3~ and the active power (P) mode. Turn on 
programmable meter M5 and close the Meter Settings dialog box. Refer to the 
Menus/View/Meter Settings help topic to obtain additional information on the 
Meter Settings dialog box.

Observe that programmable meter M5 displays active power, the displayed value 
being very close to the three-phase active power calculated in the previous step. 
This method of measuring three-phase power using a single line-to-line voltage 
and a single line current is valid only when the three-phase circuit is balanced.

8.

Three-phase power in balanced circuits can also be measured using power 
function PQS2 (U2, I2) 3~ and inputs U2 and I2 of the DACI module, power 
function PQS3 (U3, I3) 3~ and inputs U3 and I3 of the DACI module or 
power function PQS4 (U4, I4) 3~ and inputs U4 and I4 of the DACI module.



Learning Unit 6 – Measuring Three-Phase Power Using the Metering Window

48 © Festo Didactic

Measuring power in three-phase circuits using the Metering 
window (two-wattmeter method)

Figure 21: Data Acquisition and Control Interface connections used to measure power in three-phase 
circuits (two-wattmeter method).

Set programmable meter M5 as a reactive power (Q) meter.

Observe that the value of the three-phase reactive power displayed by 
programmable meter M5 is near zero. This is normal because a Resistive Load 
module draws a negligible amount of reactive power from the three-phase power 
source.

9.

Set programmable meter M5 as an apparent power (S) meter.

Observe that the three-phase apparent power displayed by programmable meter 
M5 is equal to the three-phase active power measured previously. This is normal 
because a Resistive Load module draws a negligible amount of reactive power 
from the three-phase power source.

10.

Turn the 3AC 400V/DC 230V Power Supply off.

Modify the connections so that the Data Acquisition and Control Interface is 
connected as shown in the following figure.

Turn the 3AC 400V/DC 230V Power Supply on.

On the Resistive Load module, make sure that the resistance of resistors , ,
and  is set to 1100 Ω.

1.

The red terminals of inputs U1, U2, I1, and I2 on the Data Acquisition and 
Control Interface correspond to the terminals marked with a plus (+) sign 
in the following figure.

Open the Meter Settings dialog box.2.
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Set programmable meter M11 as a three-phase active power meter (two-
wattmeter method) by selecting power function PQS1 + PQS2 and the active 
power (P) mode, then turn on programmable meter M11.

Set programmable meter M5 as an active power (P) meter, then close the Meter 
Settings dialog box.

Notice that programmable meter M11 indicates active power, the displayed value 
being virtually equal to the active power displayed by programmable meter M5, 
and very close to the three-phase active power calculated above.

On the Resistive Load module, set the resistance of resistor  to 2200 Ω to 
unbalance the three-phase load. While doing this, observe that the values of 
active power displayed by programmable meters M5 and M11 change because the 
three-phase circuit is now unbalanced.

Observe that the values of three-phase active power displayed by programmable 
meters M5 and M11 differ. The correct value is displayed by programmable meter 
M11 because the two-wattmeter method of measuring power is valid whether or 
not the three-phase circuit is balanced.

3.

In the Metering window, select the single refresh mode. To do so, choose the 
corresponding command in the View menu or click the corresponding button in 
the toolbar.

4.

Close the Metering window.5.

Close LVDAC-EMS.6.

Turn the AC 24V Power Supply off.7.

Turn the 3AC 400V/DC 230V Power Supply off.8.

Turn electric power off at your workstation. Remove all circuit connections, 
finishing with the equipment earthing connections. Return all equipment to its 
storage location.

9.
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